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ЛАБОРАТОРНА РОБОТА №1

Синтез логічних схем малої інтеграції в ПЛІС в графічному режимі з використанням САПР Altera QUARTUS II
1. Мета роботи
Метою роботи є знайомство з САПР для ПЛІС Altera Quartus II, а також вивчення способів синтезу логічних схем і мінімізації логічних функцій. (https://www.intel.com/content/www/us/en/programmable/downloads/download-center.html) наприклад Version 16.1 – Lite Edition.
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В Quartus Prime Lite Edition скачати: Quartus Prime (includes Nios II EDS), ModelSim-Intel FPGA Edition (includes Starter Edition), Cyclone IV device support.

2. Короткі теоретичні відомості
2.1. Способи синтезу логічних схем

Будь-яка логічна схема без пам’яті повністю описується таблицею істинності. Ця таблиця є вихідною інформацією для синтезу схеми на основі логічних елементів "І", "АБО", "НІ". Для розробки потрібного цифрового приладу спочатку на основі таблиці істинності записують його логічний вираз. Потім з метою спрощення цифрового пристрою мінімізують його логічний вираз і розробляють схему, яка виконує отриманий логічний вираз. Логічний вираз можна отримати двома способами:
· на основі досконалої диз’юктивної нормальної форми;
· на основі досконалої кон’юктивної нормальної форми.

Досконала диз’юктивна нормальна форма (ДДНФ)представлена сумою груп. Кожна група являє собоюмінтерм – добуток, в який входять всі змінні.

Наприклад,

[image: image2.png]F(A,B,C)=A-B-C+A-B-C+A-B-C




Досконала кон’юктивна нормальна форма (ДКНФ) представляється добутком груп. Кожна група являємакстерм – сума, в яку входять всі змінні

Наприклад,

[image: image3.png]FABC=(A+B+C)-(A+B+C)-A+B+ O




Якщо схема має декілька виходів, то кожен вихід описується своєю функцією. Така система функцій називається системою власних функцій.

Приклад:

Таблиця 1.1

Таблиця істинності для функцій трьох змінних

	A
	B
	C
	Y
	Мінтерм
	Макстерм

	0
	0
	0
	0
	[image: image4.png]
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	0
	0
	1
	1
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	0
	1
	0
	0
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	0
	1
	1
	1
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	1
	0
	0
	0
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	1
	0
	1
	0
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	1
	1
	0
	1
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	1
	1
	1
	1
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ДДНФ складається на основі таблиці істинності шляхом додавання (логічне "АБО") всіх тих мінтермів, для яких вихід Y має значення 1.

[image: image20.png]Y=A-B-C+A-B-C+A-B-C +A-B-C




ДКНФ складається на основі таблиці істинності шляхом добутку (логічне "І") всіх макстермів, для яких вихід Y має значення 0.

[image: image21.png]Y=A+B+0)-A+B-0O)-A+B+0)-A+B+0C)




На основі отриманих виразів можна скласти схему пристрою, що реалізує задану функцію. Схема пристрою, отримана на основі ДДНФ, зображена на рис. 1.1, ф на основі ДКНФ на мал. 1.2.
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Рис. 1.1 – Схема приладу, отриманого на основі ДДНФ
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Рис. 1.2 – Схема приладу, отриманого на основі ДКНФ

2.2 Карти Карно

З метою спрощення схеми цифрового приладу використовують мінімізацію функції. Карти Карно є наглядним методом для спрощення булевих рівнянь.

На рис. 1.3 показана карта Карно для функції, описаній в табл. 1.1. Верхній рядок карти дає 4 можливих значень для змінних Aі B. Ліва колонка дає 2 можливих значень змінної C. Кожна клітинка карти Карно відповідає рядку таблиці істинності і містить значення функціїY із цього рядка. Наприклад, верхня ліва клітинка відповідає  першому рядку таблиці істинності і показує, що значення функції Yбудедорівнювати0, коли ABC = 000. Як і кожний рядок в таблиці істинності, кожна клітинка карти Карно є визначений мінтерм.

Кожна клітинка (мінтерм) відрізняється від сусідньої зміною тільки однієї змінної. Це означає, що сусідня клітинка відрізняються тільки в значені одного літерала, значення якого "істина" в одній клітинці і "обман" в сусідній. Змінні Aі B комбінуються в верхньому рядку у вигляді коду Грея: 00, 01, 10, 11. На відміну від бітового порядку по зростанню величини (00, 01, 10, 11), в коді Грея сусідні записи відрізняються тільки на один розряд.
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Рис.1.3 – Функція трьох змінних:

а – карта Карно, б – ката Карно з мінтермами 

Карти Карно також "кільцева". Клітинка з самого правого краю таблиці є сусідньою із самою лівою, так як вона відрізняється тільки в одній змінній (A). Можна згорнути карту в циліндр, з’єднавши краї, і навіть в цьому випадку сусідні клітинки також будуть відрізнятися тільки в одній змінній.

На карті Карно рис. 1.3 містить чотири одиниці, що відповідають числу мінтермів в рівнянні. Читання мінтермів із карт Карно в точності відповідає читанню ДДНФ із таблиці істинності.

Карти Карно допомагають спрощувати графік, обводячи одиниці в сусідніх клітинках овалами, як це показано на рис. 1.4. Для кожного овалу пишуть і відповідну йому імпліканту. Змінні, для яких пряма і комплементарна форми попадають в один овал, виключаються. 

[image: image25.png]



Рис. 1.4 – Мінімізація за допомогою карти Карно

Таким чином, отримуємо функцію[image: image27.png]Y = AC + AB



, на основі якої створимо нову схему пристрою (рис. 1.5).

[image: image28.png]



Рис. 1.5 – схема приладу, отриманого після мінімізації логічних функцій

Порівняйте з рис. 1.1 і 1.2, схема вийде на багато компактнішою.

Правила для знаходження мінімального рівняння із карт Карно наступні:

· Використовується менше всього овалів, необхідних для покриття всіх 1;
· Всі клітинки в кожному овалі обов’язково містять 1 або значення X);
· Кожен овал повинен охоплювати блок, число клітинок якого в кожному напрямку рівне  степеню двійки (тобто 1, 2, 4, 8 і т.д.);
· Об’єднати клітинки можна тільки по горизонталі чи вертикалі;
· Кожен овал повинен бути на стільки великим, на скільки це можливо;
· Овал може зв’язувати краї карти Карно;
· Одиниця на карті Карно може бути обведена безліч разів, якщо це дозволяє зменшити число овалів, які будуть використовуватися.

3.  Завдання до роботи

1. Синтезувати логічну схему на основі дворівневої логіки (ДКНФ або ДДНФ) по таблиці істинності свого варіанту (див табл. 1.3).

2. Запустити в середовище Altera Quartus II і створити новий проект (меню File → New Project Wizard…). Майстер створення проекту містить 5 кроків:
· Крок 1 – ім’я проекту і директорія його зберігання (рис. 1.6).

Увага! Не допускати використання в іменах файлів проекту і в шляху їх зберігання кириличних символів. Для зберігання кожного проекту використовувати окрему папку на диску.

[image: image29.png]Directory, Name, Top-Level Entity [page 1 of 5]
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Рис. 1.6 – Вибір директорії й імені при створенні проекту

· Крок 2 – Додавання в проект других необхідних файлів. В даній роботі етап необхідно пропустити.

· Крок 3 – Вибір сімейства і назви ПЛІС, під яку створюється проект. Необхідно вказати сімейство Cyclone IV E, назву EP4CE115F29C7. Щоб прискорити процес вибору типу ПЛІС, можна використати фільтри по корпусу, числу виводів, класу швидкості, а також по імені, ввівши символи, що входять до назви (див. рис. 1.7).

[image: image30.png]Show in ‘Available devices' list

HardCopy compatible only a





Рис. 1.7 – Використання фільтра по імені при виборі типу ПЛІС

· Крок 4 – Вибір інструментів для синтезу, налагодження і симуляції. В даній роботі етап необхідно пропустити.

· Крок 5 – На останньому кроці відображається сумарна інформація по проекту. Для завершення створення проекту потрібно натиснути кнопку "Finish".

3. Добавити в проект новий файл (File → New…) типу "Block Diagram/Schematic File" і накреслити синтезовану схему, використовуючи інструменти "Orthogonal Node Tool" (з’єднувальні провідники),"Pin Tool" (вхідні і вихідні порти), "Symbol Tool" (логічні елементи). Altera Quartus II уже містить в своїй бібліотеці стандартні символи простих логічних елементів ("and", "ar4", "not"і т.д.) (див. рис. 1.8).

4. Зберегти файл, не змінюючи назви файлу, і виконати аналіз і синтез проекту (Processing → Start →Start Analysis & Synthesis). У випадку відсутності помилок зробити призначення виводів (меню Assignments → Pin Planner) на полі Location нижній частині вікна Pin Planner відповідно до першого і другого рядка табл. 1.2.
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Рис. 1.8 – Бібліотека стандартних логічних елементів в Altera Quartus II
Для того щоб отримати часову діаграму потрібно (https://www.youtube.com/watch?v=a8JAkKhxlQI) вибрати File → New…University Program VWF. Далі натиснути правою кнопкою на білому полі ліворуч і вибрати Insert Node or Bus + Node Finder. Далі List, виділити усі піни і натиснути в центрі на « > ». + Ok, Ok. Далі лівою миші на тискаємо на pin in і в меню вибираємо Edit – Value – Overwrite clock, вибираємо період прямокутного сигналу. Edite – Set End time (us - мікросекунди) – можна виставити тривалість симуляції. В кінці Simulation – Run functional simulation.
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Рис. 1.9 – Вікно часової діаграми (University Program VWF)
5. Виконати повну компіляцію проекту (Processing → Start Compilation). В процесі компіляції створюється конфігураційний файл *.sof в папці з проектом в підпапці "output_files". Він використовується при програмуванні ПЛІС.

Таблиця 1.2

Назви виводів схеми

	Сигнал
	A
	B
	C
	Y

	Вивід ПЛІС
	AC27
	AC28
	AB28
	G19

	На стенді
	SW2
	SW1
	SW0
	LEDR0


6. В присутності викладача підключити лабораторний стенд до комп’ютеру і включити на стенді живлення.
7. Запрограмувати навчальний стенд (меню Tools → Programmer) і, встановлюючи на входах схеми за допомогою перемикачівSW2..SW0 всі можливі кодові комбінації із таблиці істинності і нагляду за світло діодам LEDR0, перевірити роботу схеми.
8. Скласти мінімізовану логічну функцію по таблиці істинності свого варіанту (див. табл. 1.3) за допомогою карти Карно. Синтезувати схему по мінімізованій функції.
9. Накреслити нову схему в Altera Quartus II в тому ж файлі і виконати аналіз і синтез проекту. Потім зробити призначення виводів і повну компіляцію проекту.
10. Запрограмувати навчальний стенд і перевірити роботу схеми на відповідність до заданої таблиці істинності.
11. Вимкнути живлення лабораторного стенду і від’єднати його від комп’ютера.
12. Зробити висновки по роботі.
4. Вміст звіту
1. Мета роботи.

2. Задана таблиця істинності і синтезована схема.

3. Карта Карно, синтезована логічна функція і схема.

4. Висновки по роботі.

5. Варіанти завдань

Таблиця 1.3

Варіанти завдань

	Варіанти
	1
	2
	3
	4
	5
	6
	7
	8
	9
	10
	11
	12
	13
	14
	15

	A
	B
	C
	Y

	0
	0
	0
	0
	1
	0
	0
	1
	0
	1
	0
	1
	0
	1
	0
	0
	0
	1

	0
	0
	1
	1
	0
	0
	1
	0
	0
	0
	1
	1
	1
	0
	1
	0
	1
	1

	0
	1
	0
	0
	1
	1
	1
	1
	0
	1
	0
	0
	1
	0
	0
	1
	0
	0

	0
	1
	1
	1
	1
	1
	0
	0
	1
	0
	1
	0
	0
	1
	0
	0
	1
	0

	1
	0
	0
	1
	0
	1
	0
	1
	1
	1
	0
	0
	0
	1
	1
	1
	0
	1

	1
	0
	1
	1
	0
	0
	1
	0
	1
	1
	1
	0
	0
	1
	0
	1
	0
	1

	1
	1
	0
	0
	1
	1
	0
	0
	0
	0
	1
	1
	1
	0
	1
	1
	1
	0

	1
	1
	1
	0
	0
	0
	1
	1
	1
	0
	0
	1
	1
	0
	1
	0
	1
	0


6. Контрольні запитання

1. Що таке ДДНФ/ДКНФ?

2. Як записати ДДНФ/ДКНФ,використати таблицю істинності?

3. Як краще синтезувати логічний пристрій (на основі ДДНФ або ДКНФ), якщо значення функції в таблиці істинності мають більше нулів, чим одиниць?

4. Як розробити логічний пристрій, якщо він має декілька виходів?

5. Що таке мінімізація логічного виразу, і які існують способи мінімізації?

6. Яким чином здійснюється мінімізація функції за допомогою карти Карно?

7. Розкажіть, як визначити таблицю істинності логічного приладу експериментально, використовуючи лабораторний стенд?

8. Написати таблицю істинності для основних логічних вентилів (І, АБО, НІ, виключне АБО).

9. Що таке проект Altera Quartus II? Для чого необхідна компіляція проекту в Altera Quartus II і як її виконати?

10. Для чого проводиться операція призначення виводів в Altera Quartus II?

